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Scratch opens up an exciting world of computer programming
for kids and other beginning programmers. To follow along with
this book and use Scratch 2, you’ll need:

* A computer with a recent Web browser (Chrome 7 or later,
Firefox 4 or later, or Internet Explorer 7 or later) with Adobe
Flash Player version 10.2 or later installed

+ A display that’s 1024 x 768 or larger
* A reliable Internet connection

* A microphone and speakers (or headphones) to record and
listen to music

Once you have a browser and Adobe Flash Player installed,
just point your browser at http://scratch.mit.edu/. You can create
a new Scratch project without logging in by clicking the Create
button. You'll want to eventually Join Scratch to create your
own account and save your projects (see how in “Join the Com-
munity!” on page 15).

You should download the projects used in this book from
http://nostarch.com/scratch/. This online resource includes
complete working projects, custom sprites, and a short Getting
Started with Scratch guide produced by the Scratch team.




NOTE The Resources file includes two versions of each game
in the book. One version is a completely finished and
playable game, perfect for young learners and anyone
who wants to build on the games in the book. The
second set of projects has no programming added, so
that students can follow along with the programming
instructions in this book. Remember, there’s no wrong
way to play with Scratch!

BUT WHAT IS SCRATCH, ANYWAY?

Scratch is a graphical programming
language that you can use for free.
By simply dragging and dropping
colored blocks, you can create interac-
tive stories, games, animation, music,
art, and presentations. You can even
upload your creations to the Internet
to share them with Scratch program-

mers from around the world. Scratch

1s designed for play, self-directed

learning, and design.

WHERE DID THE NAME SCRATCH
COME FROM?

Scratch is named for the way that hip-hop disc jockeys (Dds)
creatively combine pieces of music, using a technique called
scratching. In the same way, Scratch programmers join different
media (images, photos, sound effects, and so on) in exciting ways
to create something entirely new.

switch costume to Party Hat




WHO CREATED SCRATCH?

Scratch is a project funded by the US National Science Founda-
tion (NSF). It was developed by the Massachusetts Institute of
Technology (MIT) Media Lab’s Lifelong Kindergarten Group.

WHO IS SCRATCH FOR?

Scratch was developed for young people aged 8 and up to help
them develop creative learning skills for the 21st century. When
kids create programs, they learn important mathematical and
computer concepts that improve their creative thinking, logical
reasoning, problem solving, and collaboration skills.

This creative thinking spiral is from Professor Resnick’s article,
“Sowing the Seeds of a More Creative Society,” published in ISTE
(International Society for Technology in Education).




Designing Scratch projects challenges kids to think cre-
atively, and learning how to overcome obstacles and solve
problems builds confidence. This gives learners an advantage
later in life.

IS IT EASY TO USE SCRATCH?

Scratch was designed to prevent the common beginner pitfalls
in traditional programming languages, like misspelling and
errors in consistency. Instead of typing commands, programming
in Scratch is performed by dragging and joining programming
blocks. This graphical interface allows users to easily control the
way in which different types of commands react to each other.
Additionally, each block can fit with another only if it makes
computational sense. Colorized categories help organize and
group different sets of related commands based on their particu-
lar functions.

Since programs in Scratch run in real time, they can be
edited and tested at any given moment, even while the program
is running. This allows users to easily experiment with new
ideas or to repeatedly test their improvements!

HOW MANY LANGUAGES DOES
SCRATCH SUPPORT?

Scratch can be used in 50 different languages. Choose your
language from the pull-down menu at the bottom of the Scratch
website.

WHERE CAN YOU USE SCRATCH?

You can use Scratch at schools, libraries, community centers,
and home. Even though Scratch is designed for young people
aged 8 and up, younger children can also learn to design and
create alongside their parents or siblings.




Scratch is used around the world in elementary, middle, and
high schools. Computer science professors also use Scratch as a
means of introducing programming concepts to college students.

HOW CAN SCRATCH BE USED TO
EDUCATE IN SCHOOLS?

Schools can use Scratch to aid teachers in subjects like math-
ematics, English, music, art, design, and information technology.
Scratch is designed for exploration and experimentation, so it
supports many different learning styles.

No matter what they use Scratch for—creative storytelling,
unique video games, or simple demonstrations of programming
concepts—Scratch will provide a space for students to explore
and imagine. By engaging in design-based activity individually
or in groups, students will be motivated to learn.

Here are just a few of the things that students have used
Scratch to do:

* A school in New York City used Scratch to build simulations
of the spread of infectious diseases.

* A group of teenagers in India used Scratch to make an
animated map of their village, illustrating environmental
concerns where they live.




Students at a university in Istanbul used Scratch to examine
video game culture by rapidly prototyping their own games
and testing the games with the public.

English students in a middle school in California used
Scratch to build a random story generator.

Students in an elementary school in Russia used Scratch to
build their own personalized tutorials for learning about the
coordinate system and trigonometry.

High school students in Michigan used Scratch to build a
physics simulator.

The possibilities are endless. It is our sincere hope that

this book inspires students to create their own games, stories,
and more.

JOIN THE COMMUNITY!

Because Scratch is online, kids can easily share their own
Scratch projects with their friends, family, and teachers. Once
someone shares their work publicly on the Scratch website, other
Scratch programmers can remix their projects, give them feed-
back, and more.

Follow these steps to join Scratch:

Visit the Scratch home page (http://scratch.mit.edu/) and
click Join Scratch to register (you only need to register
once).

Choose a username (don’t use your real name), and then fill
out the rest of the information. If the person registering is
under 13, Scratch will ask for the email address of a parent
or guardian.

NOTE Once you share a project, everyone in the whole world

can see what youve made! Make sure that your kids




or students know to keep their personal information
private.

As long as they have the username and password at hand,
kids can find games to play through the project gallery, remix
them, and share their thoughts with others from around the
world! To see how someone else’s game was built, just click the
See Inside button (). To add to the program, click the
big orange Remix button ( ).

To share your own projects with the rest of the world, click
the big Share button (| == ) in the Scratch editor. To make a
project private again, click the Unshare button in the My Stuff
listing.

Just remember that as a member of the Scratch community,
you’ll be sharing projects and ideas with people of all ages, all
levels of experience, and all parts of the world. So be sure to:

*  Be respectful of other players

*  Be constructive when commenting
*  Help keep the site friendly and fun
+  Keep personal information private

For more ideas and information about sharing and remixing
projects, visit http://wiki.scratch.mit.edu/wiki/Remix.




MY COMPUTER CAN'T RUN
SCRATCH 2!

If your computer doesn’t meet the requirements listed on

page 10, you can still download and install Scratch 1.4. (http://
scratch.mit.edu/scratch_1.4/). Scratch 1.4 projects are compat-
ible with the Web-based Scratch 2, and you can still share your
projects on the Scratch website using Scratch 1.4. (Unfortunately,
Scratch 1.4 cannot read programs created in the Scratch 2
software.)

You can download free PDF versions of Chapters 1 and 2,
which explain how the older 1.4 interface works, by visiting
http://nostarch.com/scratch/. You can also find versions of the
book’s games that are compatible with 1.4 on that page.

I'M AN EDUCATOR USING SCRATCH

Awesome! This book is great place to start for classes and after-
school programs. You'll want to download the free Educator’s
Guide at http://nostarch.com/scratch/. Visit the official Scratch
educator’s forum at http://scratched.media.mit.edu/ to exchange
resources, share success stories, and ask questions of other edu-
cators already using Scratch as an educational tool.

| STILL HAVE OTHER QUESTIONS...

You can find more information on the Scratch website:

Visit the Scratch FAQ at http://info.scratch.mit.edu/
Support/Scratch_FAQ/.

+  Visit the Scratch Help at http://scratch.mit.edu/help/.

“Online Resources” on page 156 has other helpful links.
For updates to this book, visit http://nostarch.com/scratch/.




The Cosmic Defenders:

Gobo, Fabu, and Pele

The Cosmic Defenders are trans-
dimensional space aliens who can
travel through space and time.
Formally deputized by the Galactic
Council, the Cosmic Defender’s duty
is to maintain the balance of the
universe.

The Dark Wizard

his ambition of destr_oying the
order of space and time.

The Dark Minions

Defenders who have fallen
to the dark side. They wor
for the Dark Wizard now.

He is a shapeless yet pOWEI’fL'll'
and vengeful spirit, whose origins
are unknown. Nothing can stop

Mitch
A computer science
student who loves to
make cool programs,
he’s passionate about
movies and art, too!
Mitch is an all-around
good guy.

Scratchy

An energetic cat living in cyber-
space, Scratchy is exactly what
you'd expect from a cat on the

Internet. He’s quite curious and
impulsive.

These pesky foes are Cosmic

k
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STAGE

1

A SOLAR STORM A FLARE
RAGES ON THE EXPLODES WITH
SURFACE OF A BURST OF
THE SUN.... ENERGY!

I SURE WISH
PROGRAMMING
WERE EASIER...

MEANWHILE, IN
SCHOOL ON EARTH...

W-WHO ARE
COME ON, YOU? WHAT JUST
WAKE UP! HAPPENED?



MY NAME |5 THAT'S RIGHT. 1 AMAZING! MY
SCRATCHY. FOLLOWED THAT NAME IS MITCH. TM A
IM FROM FLASH OF LIGHT, AND COMPUTER SCIENCE

CYBERSPACE. HERE I AM! STUDENT!

YOU'RE FROM A
COMPUTER?!

OHNO!'1
CAN'T MOVE
MY LEGS!

HEY MITCH.

UM...1$ YOUR WHERE 1S

PLANET ALWAYS
50 GRAY? EVERYBODY?
AHHH!

ME NEITHER!
SOMETHING HELP!!
TERRIBLE 15
FORMING IN
THE 5KY!
NO WAY!
SOMETHING'S
WRONG. LET'S
GO CHECK
IT OUT!

TAKE THIS
SECRET MANUAL
STAY CALM! BEFORE THE
THANK GOODNESS BLACK TORNADO
I FOUND You! < SWALLOWS You!

THEN FOLLOW MY
YOUR BODY 15 INSTRUCTIONS!

BEING FROZEN!




Let’s get to know Scratch!
WEe'll also learn about sprites
and coordinates.
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To follow along with the Secret Manual,

you first need to open Scratch. Once you
Create a new project, you'll see Scratchy
the cat on a white backdrop. The cat doesn’t
do anything yet because he doesn't have any
programs. Scratch calls Scratchy the cat—
and all the other characters and objects we
add to a project—a sprite. Soon, we'll start
giving him directions to move by using the
blue blocks in the middle of the screen.
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Sprites

You'll need to give each sprite its
own instructions. In other games
we play, we'll have more than one
character to control, so we'll have
more than one sprite listed here, in
the Sprite List. To give a particular
sprite instructions, click a sprite in
the Sprite List first and then drag
blocks into the Scripts Area.

BREAKING THE SPELL!

We need to get Scratchy the cat
moving again. We'll make him
dance across the Stage.

Sounds

The command blocks you

can give a sprite are here.
We'll stack these commands
together to break the magic
spell and get Scratchy back on
his feet. The blocks here are
all blue, as they're from the
Motion palette.

/4
Saved [E nostarchv
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{ V6
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v

To move a block, just click and
drag it over here. This is called
the Scripts Area. It's where we
write our programs.

Now let’s take a closer look
at the rest of the interface...
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Sprite Toolbar
Contains the

A Guided Tour of the Scratch Interface!

Palette
Each of these ten buttons lets you choose
functions (called blocks) for programming your

Play the Give your Duplicate, Delete, sprites. You can combine these command
game full project a Grow, Shrink, and blocks in stacks to create programs that
screen. new name. Block Help tools control objects on the screen.
71 1 1
BEME © rev eav Tis L Saved [ nostarcn v
" — R @) e [onm g S
[ Looks J contral (g;
Stage ISnunn ISEnsmg e
. . I ren [ operators y: 0
Displays your creation s R i locts
O Scripts Area
Q@ Here's where you build your
programs. Stacking blocks
The green flag starts the together here lets you control
game and the red flag the sprites in your project. Click
stops the game. one of the three tabs at the top
to change to other functions:
Sprites Scripts: Allows you to
i drag command blocks from
the Palette and put them
change v by € together to write a program

Sprite List b poc b ; "
Here are the characters or a sprite
and objects you've created, ) Sounds: Allows you to record

including the Stage itself.
Click the icons to edit each
sprite individually.

Backpack

New Sprite Buttons

Costumes: Allows you to
draw, import, or edit images

or import sound files for a
sprite to use

There are four ways to add a sprite:
e Pick one from Scratch’s built-in library

e Draw a new one

e Upload an image you already have

e Take a photo with your computer’s webcam
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Sprite Information
You might have noticed a little blue i in the corner of the box around
Scratchy when you select his sprite in the Sprite List. Try clicking the i,
and you'll get information about that sprite.

This section shows the sprite’s name, position, and direction it is facing
(the little blue line).

This is how you can rename the Scratchy sprite.
Right now it's Spritel. Don't you think that's a
little boring? Try renaming this sprite.

A\
\
Sprites New sprite- ‘@ / & £
S 0) |.Supreme Cat #1
‘ = x: 0 y: 0 direction: 90° =
Q2 rotation style: — °
(& (.:m drag in |_\|a-}e?: E ) k
. B ‘
\
1
Click this arrow when Rotation Settings Try clicking and
youre done with the You can control how a sprite dragging the little
Sprite Settings pane. rotates in three ways: blue line—see what
We'll play with these e Can rotate freely happens to Scratchy’s
other settings later. e Can face only left or right orientation.
¢ No rotating allowed
Now, onto the fun stuff. To use Scratch to program il 5 N Wi
movements, you first have to understand how B [backdropt
Scratch positions things. h/aB
1
Click the Stage icon in the Sprite List. Switch to o \
the Backdrops tab in the Scripts Area and choose 2 backdrops
Choose backdrop from library. New backdrop: backdrop1 -
E/an L=
Note: Sprites have costumes while the Stage has [ ]
backdrops.
Choose Backdrop Library
the xy-grid W
backdrop and
click OK to All L.
use it. It's in Indoors @ @
the “Other” Qutdoors . o/
category. Otfsx Xy-grid -
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Now you can see exactly how Scratch positions objects.
Everything is on a grid with two axes:

y-axis: A vertical line that marks up and down positions;
ranges from =180 (lowest) to +180 (highest)

x-axis: A horizontal line that marks left and right positions;
ranges from -240 (farthest left) to +240 (farthest right)

Scratchy’s default position is at the point where the x-axis
and y-axis meet. His coordinates are (X: 0, Y: 0).

Now we can program movements for
Scratchy the cat! But first, try dragging
him to the top of the Stage, as shown
on the right.

Note: The bottom-right corner displays
the coordinates of your mouse. This
will be really helpful when we start
setting the positions of sprites!

(%:-240,¥:0) (%:0,¥:0) (%:240,¥:0)
» =]

The current coordinates of a sprite are
shown in the upper-right corner of the

Scripts Area, too.
o8 | (x:0,¥:-180)
o o ¥. 125
w0

y: 125

Scripts Costumes Sounds

ILooks :Control
ISound ISensing
IF'en IOperators
I Data I More Blocks

nmemsteps

turn (4 €0) degrees
To makg sure v}ve’re} gi\(ing Scrat;hy t‘he cat torn ) €D degrees
instructions, click him in the Sprite List (the
box at the bottom left of the screen). Switch to A
the Scripts tab in the Scripts Area and then
click the Motion palette button. Click and drag point towards V4

out the command block to the ’
Scripts Area. gotox:@® v: O ’

point in direction ,

’
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We want Scratchy to move
around, but at the moment, he
moves too fast for us to see! To
make him move more slowly, click
the Control palette and drag out
the command to the
Scripts Area. Make sure to drag it
under your blue command block.
Wait for a white line to appear and
then release the mouse.

go to x: ) y: €D

The two commands are joined
together! Now change the time
to 0.1 secs.

Tip: If you want to separate the
commands, simply drag away

the block. If you want to delete a
block, simply drag it back to the
palette. Give it a try. To move a big
stack of blocks, click and drag the
topmost block in the stack.

go to x: @ v: €D

Scripts

J otion
ILUDks
ISuund
IF'en
J pata

Costumes Sounds

I Events

ISensing
IOperators
| ore Blocks

Click the number of a coordinate to change it. Set x to 0 and
set y to 125. Now click the block to run it! Scratch goes right
to that position. We've just written our first program! It's really
that simple.

Next, select the
Duplicate button on
the Sprite Toolbar
and stamp it on the
commands to make
five copies.




Type these coordinates in your
own program, so it matches this
picture. When you're finished,
click the whole command block
to make Scratchy jump around
in a pentagon shape!

To make him move in a loop continuously, drag out the
command block from the Control palette and place
it at the top of the code. Click the block, and it will actually
run! Click to stop Scratchy from moving around. You can
test any program in this way—just click it with your mouse.

Tip: Whenever youre writing scripts, you'll want to test them

every now and then to see if they work the way you expect.
y

ﬂem:;ers to x:@v:m

Now let's make Scratchy glide around instead of
-~ glide (Y secs to x: D) v: EFD

jumping from point to point. To do this, click the

Motion palette, drag out five commands, glide (X secs to x O v: €D
and join them together. Follow the picture on glide @8 secs to x: €D v: EED

the right, and copy the seconds and coordinates. glide (XD secs to x: EED v: ED
Once you're finished, click the script to see the
results!

Now we can join these two programs together! From

the Events palette, drag out the
command and put it at the top of your two scripts.

Tip: We'll often need multiple scripts to start at the

same time, and using the command
will help us do that.

J B
gide @ secs to x €D v: €
gide @) secs to x €D y: €D
alide (XD secs to x: O y: €D
' glide (XD secs to x: € y: €MD
giide @B secs to x: €D v €D




30OVYLS

Next, click the Pen palette
and drag out the four green
Pen blocks shown on the
right. Now when Scratchy
moves, he'll draw a magic
star web!

vy | (%:0,¥:180)

(¥:-240,¥:0)

Scripts

| motion

| ] ]
i [ B o
] = =]
= = o
B 5 =

a

|
Because we used the command, we

can use these buttons above the Stage to start (/=) F .
and stop (@) the game.

Costumes Sounds

J Events
l Control

set pen color to

pen color bv'm

set pen color tn'ﬂ

change pen shade by €0

set penshalletom

change pen size by €3

TR

set pen size tno

(%:0,¥:-180)

Wo‘\\é‘e

(¥:240,¥:0)

ISensing
IOperators
IMore Blocks

set pen color to

set pen size tnm

go to x: @ v: @D
0.1}

glide (XD secs to x: D v: EED
3

gillem::ers to x:ﬂv:@

3

gideﬂ'sers to x: ‘Iﬂt’ v -—110
3

' gide @) zecs to x: €D v: €)

Occasionally, when you run your program,
there is a software bug. This is the most
exciting part of computer programming:
discovering an error in something you
have made and then solving the problem.
In this case, sometimes Scratchy will
draw an odd line at the beginning of the
program.

If we drag Scratchy anywhere else on

the Stage and then press M, he draws an
extra line because he starts in the wrong
place. Try doing this multiple times to see
if you can spot the bug.




(¥:-240,Y:0)

This software bug can be fixed by adding
some more code—that is, new blocks—to
your program. In this case, simply place

anew block (from the blue Motion
palette) above the green Pen blocks and

below the block.

With this little correction, Scratchy will
always begin drawing from the correct
position in the grid. The bug is gone!

_4
Ad
VAN
vy [(%:0,¥:180)
(%:240,Y:0)
X

(%:0,¥:-180)

set pen color to

set pen size tnm

,bgillemsers to x: EED v: €D
b._.ns.:d![lserstn e 100 B 120
glide XY secs to x: @ v: €D
P|_|ill|=ﬁ!)-"n=rs (= 100 B9 -120 )
' giide G secs to x: €LD v: €

Let’s add a whole new program to
make a magic star web that changes
colors. Build a second stack of blocks

that uses the

command and see what happens.

Isn’t that cool? You can give a single
sprite more than one set of blocks!
Scratchy now has two programs. This
tiny second program sure makes a big
difference in how the game looks.



3OVYLS

GFEIE & o Edtv Ties

w33

T} [01-Breakif]

by nostarch 5 e

Save as a copy

Go to My Stuft

Upload from your computer

Download to your computer

Revert

Remember to save
this file so you can
play with it later!

B
[ce)

<[~ Tvler ~ My Sweet Saratch Projects:

[ Search My Sneet Scraten Pro

Organize ~ e folder =- @
Yo o [vmties e fs= | |
. Mo tems match your search.

4 Libraries
& Homegroup
18 Computer
€ Network
Fie name: [My First Program.sb2 =l
Saveas type: [ Fies =l
e =
7

If you are logged into Scratch, the website stores all of your projects into
My Stuff so you can easily find them. The website saves your progress
every so often, but you can save manually too: File » Save Now. You can
also save different versions of your programs to make sure you don't lose
older versions of your games and can safely experiment—File » Save Copy
creates a new version of your project in My Stuff. If you want to download
a version for yourself, try File » Download to your computer. Then save

it in a safe spot!

Scratchy’s Challenge!!

Can you edit this program to make Scratchy draw

different kinds of shapes? Give it a try!







STAGE

MAGIC
STAR WEB!

NICE WORK!
YOU'VE BROKEN
THE DARK
WIZARD'S SPELL!

MY NAME IS
GOBO. IM
A COSMIC

THAT SOLAR
DEFENDER!

FLARE
DESTROYED
THE BALANCE
BETWEEN THE
DIGITAL WORLD
)\ AND THE REAL
WORLD!

ALRIGHT! I CAN
FEEL MY LIMBS
AGAIN!

WHO ARE
YOU AGAIN?

THIS UNIVERSE 1S
NOW CONTROLLED BY THE
DARK WIZARD AND HIS MINIONS.
THEY FROZE ALL THE COSMIC
DEFENDERS BESIDES ME—

AND ALL THE HUMANS
. ON EARTH.

32



THIS SECRET

\/ MANUAL SAVED

US. MAYBE
IT CAN HELP
OTHER PEOPLE
AS WELL!

OH NO!

MY FELLOW
DEFENDERS ARE IN
TROUBLE! CHANGE
INTO A SPACE SUIT

AND SAVE THEM,

KIND FELINE!

BY THE WAY,
GOBO, MY NAME
IS SCRATCHY, AND
HE'S MITCH!

GREAT IDEA!
YES! IF I LEARN YOU CAN DESIGN
TO PROGRAM, IT NEW EQUIPMENT AND

MIGHT HELP TO EVEN CONTROL OUR
DEFEAT THE DARK MOVEMENTS!

WIZARD!

WE NEED THE
ENERGY FROM SEVEN
ALRIGHT! DIMENSIONAL STRINGS

BUT WHY DOES
SCRATCHY NEED TO o::g ggi c‘ﬁﬁ,@m&
THE SPACE SUIT?

FRIENDS...

..BUT INSIDE THE
VORTEX, THERE'S NO

| OXYGEN, AND LIGHTNING
CAN MAKE THINGS
DISAPPEAR!

WOW! IT'S FULL
OF STARS!

THE ADVENTURE INTO
SPACE BEGINS...



A SPACE ODYSSEY!

Learn to design new costumes Avoid the lightning bolts and

and program a sprite’s move- collect seven dimensional strings.

ments, reactions, and sound Once you've got them all, the
STAGE effects. Monolith will appear!

To make things really easy, let’s start by opening
a blank project called 02 - A Space Odyssey.sb2.
This project has all the sprites you'll need, but
none of the programming yet. To open a file, click
File » Upload from your computer.

Upload from your computer

Download to your computer
Revert

But let's try making some sprites of our own, so
you can make changes to this game's characters
and invent your own games, too! Click Scratchy’s
sprite icon in the Sprite List, and then click the
Costumes tab. You'll see the Paint Editor—just
be sure to click the costume you want to change.

At the top of the Paint Scripts | Costumes | Sounds m
Editor, you can give your “;“’;E”’; [Scratchy CM Clear gl
Costume a name. We =
can then reference the ; = &
costume names in our W%a; R
programming. el -

&Bx114
If your Paint Editor L
looks different, it could , T
be because you haven't S
opened the blank project = &
file (02 - A Space Odyssey &
.sb2) that has Scratchy’s -
astronaut costume. i

-+

Scratch has two modes
for editing graphics—

on the right is Bitmap
mode. See page 38 to
learn more about editing

in Vector mode. A RUISIS

200%

Bitmap Mode
Convert to vector



Here's where all the tools
are. The Brush and Eraser
tools make it easy to draw.

n o Clear ENES

The Eyedropper tool will
match the current color to any
color you click in your image.

I

Scripts Costumes Sounds
New costume: |'S Lichy
d/ad v
; &
Astro-Cat | |
3x114
®
92 T
Scratchy Y \
B5x111 &
Use the Fill tool to color big =4
parts of your drawing at once. !
You can choose a single color 1
from the palette or use a
gradient effect from the Tool
Options.
0

. HEN /

[ ]
=IIIII==

Bitnfap Mode
Coglvert to vector

/

Whatever tool you are using, the options
for the tool will appear at the bottom of
the Paint Editor. For example, the size
of the Brush or Eraser can be adjusted
if you want to make a big drawing or
add fine detail. Just click and drag here
to pick the right size.

Tool Options

You pick a color for your tool here, too.

Click the Zeom buttons (the magnifying
glasses on the bottom right) to zoom in
or out on your creations. This will make
it easier to draw! Clicking the equals sign
(=) shows you exactly how your sprite
will appear on the Stage.

If you're not sure what a button does,
simply hover your cursor over it, and a
description will appear!




STAGE

You also have tools to draw rectangles and ellipses.
Can you give Scratchy a stovepipe hat like Abe
Lincoln using the Rectangle and Ellipse tools?

ofa/ &+

These shapes can be empty inside
or filled in. Try experimenting with
different colors for the inside and
outside. If you press the SHIFT key
when you start to draw, you'll
’) have a perfect circle or square!

(You can also use this SHIFT trick
a when using the Line tool to draw

a straight line.) Try rotating your
shapes using the handle on the
top of the box.

NI A

Q= Q

400%

Bitmap Mode
Convertto vector

ofo/ (& 1+

3
i)
o

]
The Text tool lets you add Mpo)

writing to your sprite. We'll
use this tool when we need
to give the player instructions
for our games. If you want

to move the text, simply click
and drag the black box that
surrounds your text.

REIT - DN

This is cool!

Q= Q

200%

Bitmap Mode
Convertto vector
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New costume:

[Scratchy o Clear ol =+
d/an
) &
Astro-Cat =]
Fren

[ ]
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o — R 5 <o oriect o
Newmﬁ"“me‘ | scratchy 5™ Clear o =+
d/anm
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Astro-Cat =
saxi1e
[ ]
4 T
T &
&
oy
oL

[ s20ee J &5 sox prkect g
RIS+

Meow!

This is cool!

To use the Select tool, use your
mouse to create a frame around a
certain area. Then you can do all
sorts of things to the selected part
of your costume:

e (Click and drag the selection to
move it to a new location.

¢ Resize, smush, or stretch the
image using the handles on the
sides of the box

e Rotate the selection by clicking
and dragging the handle at the
top center of the box

e Press and hold the cTRL key and
C key at the same time to copy
the image area (Mac users can
use 38-C instead). Then press
CTRL-V to paste your selection,
as many times as you like.

e Press the DELETE key to erase
the selection.

The Set costume center
button marks the center of
your sprite. This helps to
make sure your sprite doesn't
end up in the wrong place
when it spins or rotates!

[sar ] 5 soeroscoo

.S
o =+
Set costume center

By using the Duplicate tool,
you can copy and stamp a
selected area as many times
as you want! Just draw a
frame around the area you
want to copy and then click
wherever you want to paste.
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Vector Mode
Hew costume:

You may have noticed that s/ 8@
when you edit other sprites in :
Scratch, you don't see the same \%
Paint Editor tools. Some newer fzit
sprites are vector art—that’s just el

a fancy way to say they're made ]
of shapes, instead of pixels. e
Vector art have small filesizes, Seratchy
but they are great quality—and
they can be resized without

losing quality.

=)
Note: For simplicity’s sake, all

— of the graphics in this book use

— Bitmap mode. But your custom
projects can use a mix of vector
and bitmap graphics.

|Space Crab

Space Crab
13481

You can switch from Scratch’s Bitmap mode (the
one seen earlier) to Vector mode by clicking the
Convert to Vector button at the bottom right of
the Paint Editor. The difference between using
these two tools in Scratch is like the difference
between Adobe Photoshop and lllustrator—or
GIMP and Inkscape. Use whichever Paint Editor
mode you like the most!

You can import SVG files into Scratch’s vector
editor. In Vector mode, you can squeeze and
shape lines, reshape, and ungroup. Here's how
the Vector mode works.

Scripts Costumes Sounds

n @ Clear o a4+
=
a3
i
N
o
O
T
e}
£
=5
=1
..
QA=Q

[ share | 6% see proctpag
ol &+
Select object— &3
Reshape a line or shape—*

200%

Vector Mode

Convert to bitmap

(click on an object, then | # — Pencil
drag its round “handles”) [~ — Line

Rectangle—

Text— T

a .
o —Ellipse

& — Fill tool

Duplicate—*

Forward a layer—1
Back a layer—T

Ungroup™ 1 *

w 4]



Try opening a vector
graphic from Scratch’s
library, and give editing

one a try butterfly3 cat1-a cati-b cat2
b
N e
dinosauri-a dinosaur1-b dinosauri-c dinosauri-d

The Backpack

Here’s a cool new feature. If youre logged into the
Scratch website, you'll see something called the
Backpack at the very bottom of the screen. Click it,
and it'll open up. Yours will be empty until you throw
some sprites in it.

Backpack @

Backpack v
B =
Sprite Sprite Sprite Sprite Script Script
Side?Side Lightning Whiptail Magic Gem

Your Backpack lets you share sprites and
scripts between projects. If you play a really
cool game on the Scratch website and want
to use the character in an entirely new
project, just click and drag the sprite right
into your Backpack.

©V© When you create a new project of your own,
just open the Backpack again and drag the
sprite out. You can write all new programs,
or use the ones that were already with the
sprite. You can even use your Backpack to

store programs you want to reuse!

ls

L/ \J

dinosauri-e
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Once you know how to use the Paint Editor’'s
tools, Scratchy can put on his space suit!

Go ahead and draw your own, or use the
costume that’s already in the project.

Because we've selected the horizontal
rotation style (circled below) Scratchy will
face only left and right.

Sprites

Stage
1 backdrop

MNew badedrop:

a/an

New sprite: ‘@ / & 3

|. Astro-Cat

x-15 w32 direction: -90° ==
rotation style: 0 £
can drag in player: [

show: B

Now we have the main
character for our game:
Scratchy the astronaut!




Next, let's take a look at the other

sprites in the game. You can use the New costume:

art that's already in the game, or d/aB

draw new artwork yourself! Click ./ T

to draw a new sprite. @
String
AGucdd

First, take a look at the String and

the Monolith. They are two costumes

for the same sprite, String. If they Monolth

were two separate sprites, we'd have =k

to write two programs. But now we

can make this sprite switch costumes

and write only one program.

T )
Now for our third new sprite, some
scary Lightning! The player will need New costume:
to avoid the lighting. d/am
Lightnin
G272
N\
We also need some instructions to
appear at the start of the game. We'll
call this sprite Banner.
a N

New costume:
d/anm

1

Banner
A0Z335

Scripts Costumes Sounds

|. String

\
|
o
T
&
&
ish
e

Scripts Costumes Sounds

|.Lightning

EQ =001 7

Scripts Costumes Sounds

|.Banner
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Next, let's look at the Stage.
| used artwork of a black hole
from NASA! You can draw a
new backdrop if you like. Click
the Stage in the Sprite List, and
then click the Backdrops tab.

Scripts Backdrops Sounds
H backdrop: P —
o C+ s [Ouasar n @ Clear bl gﬂ +
e/
|
&
s
i
[ Pl LY a=q
[ ]| 100%
HE ENEEE
HE HE Bitmap Mode
.‘ T TT]
0 - EEEEEEEE Convert to vector

Now that we have a bunch of sprites for the
game, you can see how everything appears in
the Sprite List. To give a sprite new instructions
or costumes, you'll first have to click it in the
Sprite List. Let’s start by giving Scratchy the
astronaut his programming.

Let’s write our first program @ for Scratchy! Make
sure he’s selected in the Sprite List and you've clicked
the Scripts tab. His first program is a short one that
makes him bounce up and down a little. This makes
him look like he’s floating in zero gravity!

Astro-Cat




For program @, we'll make a conditional—if something
is true, then something else will happen. In the Control
palette, drag out an f&j block. Then for the diamond shape,

drag the Sensing block [EIINTTEETE. Right below

the . put what you want to happen when the statement

is true. Drag out the rest of these commands to form the

complete program. Now you can move Scratchy up, down,
left, and right by using the keyboard!

~ | Now we'll give Scratchy two more programs. We'll need to
- R s ] program them individually, and then use [T INEEETEET]
change y by €5 to make them all run at the same time.

-_ key left arrow prﬁsed'! l]nnn
i point in direction
s
change x by &5

.key right arrow  pressed? IIIEII

point in direction m
»

Let's write programs © and @. Click the Control
and Looks palettes and drag out these commands.

Program @ controls which costume Scratchy
wears, and program @ makes Scratchy become
invisible like a ghost each time he gets struck by
lightning.

When you've finished all of this, Scratchy’s
programming is complete!

Next, let’s click the Banner sprite.
We just need a simple program to
make these instructions appear at
the start of the game. The
loop using the and blocks
makes our instructions flash, so the
game is even more exciting.

Yyp— ”

o
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(Y

Now we can add sound effects to the game!
I've already added a few, but you can change
things up. First, click the Stage in the Sprite
List. Then click its Sounds tab. You can create
whatever kind of sounds effects or music you
like for your Scratch projects. You can even
record your own sounds right in the Scratch

Scripts Costumes Sounds

New sound:

< & @
program.

If you click the Record button, a sound recorder will pop up.
You can click the round button to record speech or sound
effects through a microphone. When you're finished, click OK.

Note: To record your own sounds, you'll need a microphone
attached to the computer. To listen to sound effects and music,
you'll need speakers.

Scripts Costumes Sounds

New sound:

€ a

1
e
LR

|recording1 H o

recording1

00:00.0

ity v
b ] Y Edit Effects

Microphone volume: 0

If you want to use sounds that are prerecorded, you can press
1§ to use Scratch’s sound library, or g} to choose files from
your own computer (MP3 and compressed WAV, AIF, and AU
formats are supported).

Sound Library

ar o o e i e e i €

Animal afro string alien creaki alien creak2 beat box1 beat box2 bell toll bird bubbles
Effects
Electronic

Huran e e e e e ' e '
Instruments < » Ll K2 Ll K 2 < » {z » {z » s » iz »

Music Loops computer beeps2  cough-female cough-male cricket crickets cymbal crash dog1 dog2

Percussion
. . . ” o ” . ”
> Wi wWiEr wE> WE» Wt r gt Wt »

Vocals
drum set2 drum duck eggs fairydust finger snap footsteps-1 garden

iz » < » iz » < » i< » i< » iz » i< »

hand clap hip hop horse gallop horse human beatbox1 ~ human beatbox2 jungle lasert
. . » . . ” . ”

> WEr wWiEr» wE> wWE» i r gt Wt »

medieval2 meow meow2 motorcycle passing owl party noise plunge pop

A= T 4 = A= A T .4s

oKk || cancel




Now we can add some simple programs to the
Stage. Program @ makes its backdrop change
colors. In program @, use the Sound palette
to add a song to the Stage.

switch backdrop to Quasar

Scripts Backdrops Sounds @ Q‘) See project paq

N d: L —
o | Technot )| e

W& a ) change color  effect by E5)
1 | ”
’
<
Technot

> H @ EditY Effects ™ bset volume to EI) o6
play sound Technoil until done

Microphone volume: O d

Next, we can add some sound effects to the
String and Lightning sprites to make the game
more exciting! Test how you like my sound
effects, and make your own if you like.

Scripts | Costumes | Sounds m 4% See project pad Scripts | Costumes | Sounds w &Y See project pag
New sound: A Hew sound: S —
5 4 |Hummmg n o / ' \Thuntler n o
(LR - ; i a
1 T 5
e s
< (<
Humming Thunder
00:00.7 00:01.7
v R ity v
» H e Edit Effects » H e Edit Effects
Microphone volume O Microphone volume: (O

You can record a sound yourself and
then change it using the Effects menu.
Try reversing what you record to make
it sound really weird!

Click the Lightning sprite, and
write a program so that whenever
Scratchy touches a lightning bolt,

..setunlmtnmib
3

play sound Thunder wntil done

a sound will play.
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The Lightning sprite needs some more
programs. Go to the Control, Events,
Looks, and Operators palettes and
program these commands to have the
lightning bolt randomly grow bigger

or smaller, making the game more
magical.

..lset size to pidtmmtnm L

Next, write this program to make the lightning
disappear whenever Scratchy touches it and to —— :
control the way it moves. [_“il pick random () to €K} |secs

go to x: | pick ra'ulnlrnmtn v:m

The lightning’s vertical position (y-axis) changes 'gn e

because we repeat eight times the subtraction of
40 steps (-40) from its original y-coordinate of 260.
To make the lightning move differently, you can
change and play with these numbers.

So that the lightning bolt makes Scratchy disappear,
we must make sure that each time it moves—that
is, the position of its y-axis changes—the program
will check if it touches Scratchy.

Tip: Sometimes when you've used
the and blocks, a sprite
can disappear while you're working
on the program—running it, testing
it, and checking for bugs. Simply click
the block in the Looks palette
to make the sprite appear again.
(You can also check the show box

in the Sprite Information pane.)

& e -,



Now it's time to program the String sprite.
Make sure you click it in the Sprite List first!
Program @ makes it change color, just like
our Stage. Program @ will give it a simple
animation, using the fisheye effect.

dear graphic effects

change color effect bve

-l:hange fisheye
change fisheye
change fisheye

change fisheye

Now for a big program. Let’s start oyl i

by dragging out the blocks you can
see in €. These will control how the
String costume spins and moves.




Then add to your program so that
it looks like @. This will make your
dimensional string appear in a
random place on the Stage seven
different times. The B blocks
and blocks at the end
of the program make sure the
player knows he has grabbed a
dimensional string.

- until  touching Astro-Cat

change y by €9

set volume to@ﬂb
3
play sound Humming

L0.2)

We're not done yet!
This is a hig script.
=



Add a [[YTEINEETEY block at the top of our script

and some instructions at the very bottom so that once
Scratchy has collected seven dimensional strings, the
String sprite will change to its Monolith costume. When
that happens, the player wins the game. Make sure
your finished program looks like ©.

switch costume to String

3
set volume to E g
3

play sound Humming

switch costume to Maonolith

=18 Stargate opened! f378 a secs

Now you're done!
Nice work!




After saving the file, you can enjoy your final
creation! Make the Stage full screen and
click /™ to begin a new round.

Scratchy’s Challenge!!

Add more lightning bolts to give yourself a
challenge. Or you could replace the lightning
bolt with a big, scary space monster you drew
yourself! Give it a try!




THE APVENTURE CONTINUES...
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IT'S SUDDEN DEATH IN THIS DEFEND THE SERVER FROM
PENALTY KICK SHOOTOUT! SNEAKY HACKER ATTACKS!

GET THE GEM AND ESCAPE THE BATTLE THE DARK WIZARD IN
BOOBY-TRAPPED MAZE! AN AWESOME FIGHTING GAME!

Buy the book at http://nostarch.com/scratch
and use SCRATCH2 to get 40% off your purchase.




